




 

 

RAS Extension Pyro V2 Kit Handbook    05/2016 28 

 
Figure 3. Placement of PCR plate and PyroMark Q24 plate on the vacuum workstation. 
 

5. Apply vacuum to the tool by switching the vacuum on. 

6. Slowly lower the filter probes of the vacuum tool into the PCR plate to capture the beads 

containing immobilized template. Hold the probes in place for 15 s. Practice care while 

lifting the vacuum tool.  

Note: Sepharose beads sediment quickly. Capturing the beads must take place 

immediately following agitation. If more than 1 min has elapsed since the plate was 

agitated, agitate the plate again for 1 min before capturing the beads. 

Inspect the PCR plate for complete uptake of all samples by the vacuum tool. 

7. Transfer the vacuum tool to the trough containing 40 ml of 70% ethanol (trough 1; Figure 3). 

Flush the filter probes for 5 s. 

8. Transfer the vacuum tool to the trough containing 40 ml of Denaturation Solution 

(trough 2; Figure 3). Flush the filter probes for 5 s. 
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9. Transfer the vacuum tool to the trough containing 50 ml Wash Buffer (trough 3; Figure 3). 

Flush the filter probes for 10 s. 

10.  Raise the vacuum tool up and backwards, over a 90° vertical angle, for 5 s to drain 

liquid from the filter probes (Figure 4). 

 

 

 

 

 

 

 
 
 
 
 
Figure 4. Illustration of the vacuum tool raised to beyond 90° vertical angle. 

 

11.  While the vacuum tool is held over the PyroMark Q24 Plate, turn the vacuum off. 

12.  Release the beads into the PyroMark Q24 Plate by lowering the filter probes into the 

diluted sequencing primer, and moving the vacuum tool gently from side to side.  

Note: Be careful not to damage the surface of the PyroMark Q24 Plate by scratching it 

with the filter probes. 

13. Transfer the vacuum tool to the trough containing high-purity water (trough 4; Figure 3), 

and agitate the vacuum tool for 10 s. 

14.  Wash the filter probes by lowering the probes into the high-purity water trough (trough 5; 

Figure 3), and apply the vacuum. Flush the probes with 70 ml of high-purity water. 

15.  Raise the vacuum tool up and backwards, over a 90° vertical angle, for 5 s to drain 

liquid from the filter probes (Figure 4).  

16.  Switch off the vacuum tool, and place the vacuum tool in the Parking (P) position. 
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17.  Switch off the vacuum pump. 

Note: At the end of a workday, liquid waste and remaining solutions should be 

discarded, and the PyroMark Q24 Vacuum Workstation should be inspected for dust 

and spills. See “Appendix B: Emptying the Waste Container and Troughs”, page 53. 

18.  Heat the PyroMark Q24 Plate with the samples at 80°C for 2 min using the pre-warmed 

PyroMark Q24 plate holder. 

19.  Remove the PyroMark Q24 Plate from the hot plate holder, and place it on a second 

PyroMark Q24 plate holder that was kept at room temperature (15–25°C), to allow 

samples cool to room temperature for 10–15 min. 

Proceed directly with “Protocol 5: Running the PyroMark Q24”, page 31. 
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Protocol 5: Running the PyroMark Q24 

This protocol describes the preparation and loading of PyroMark Gold Q24 Reagents, into 

the PyroMark Q24 Cartridge, and starting and finishing a run on the PyroMark Q24. For a 

detailed description about how to set up a run, see the PyroMark Q24 User Manual. 

Important points before starting 

 The pre-run information report, found in the “Tools” menu at run setup (see “Protocol 1: 

Run setup for the PyroMark Q24 system”, page 18), provides information about the 

volume of nucleotides, enzyme, and substrate buffer needed for a specific run. 

 Load the cartridge with disposable tips (without hydrophobic filters), to ensure correct 

functioning of the cartridge.  

Procedure 
1. Dissolve the freeze-dried enzyme and substrate mixtures in 620 µl water (H2O, supplied). 

2.  Mix by swirling the vial gently. 

Note: Do not vortex! 

To ensure that the mixture is fully dissolved, leave the mixture at room temperature (15–25°C) 

for 5–10 min. Make sure the solution is not turbid before filling the PyroMark Q24 

Cartridge. If the reagents are not to be used immediately, place the reagent vials on ice, 

or in a refrigerator. 

3. Allow the reagents and the PyroMark Q24 Cartridge to reach ambient temperature 

(20–25°C). 

4. Place the PyroMark Q24 Cartridge with the label facing toward you. 

5.  Load the PyroMark Q24 Cartridge with the appropriate volumes of nucleotides, enzyme, 

and substrate mixes according to Figure 5. 

Make sure that no air bubbles are transferred from the pipet to the cartridge. 
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Figure 5. Illustration of the PyroMark Q24 Cartridge as seen from above. The annotations correspond to the label on 
the reagent vials. Add enzyme mixture (E), substrate mixture (S), and nucleotides (A, T, C, G) according to the volume 
information given in the Pre Run information report, found in the “Tools” menu at run setup. 

 

6. Open the cartridge gate and insert the filled reagent cartridge with the label facing out. 

Push the cartridge in fully, and then push it down. 

7. Make sure the line is visible in front of the cartridge and close the gate. 

8. Open the plate-holding frame and place the plate on the heating block. 

9. Close the plate-holding frame and the instrument lid. 

10. Insert the USB stick (containing the run file) into the USB port at the front of the instrument.  

Do not remove the USB stick before the run is finished. 

11. Select “Run” in the main menu (using the  and  screen buttons) and press “OK”. 

12. Select the run file using the  and  screen buttons.  

To view the contents of a folder, select the folder and press “Select”. To return to the 

previous view, press “Back”. 

13. When the run file is selected, press “Select” to start the run. 

14. When the run is finished and the instrument confirms that the run file has been saved to 

the USB stick, press “Close”. 

15. Remove the USB stick.  

16. Open the instrument lid. 

17. Open the cartridge gate and remove the reagent cartridge by lifting it up and pulling it out. 

18. Close the gate. 
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19. Open the plate-holding frame and remove the plate from the heating block. 

20. Close the plate-holding frame and the instrument lid. 

21. Discard the plate and clean the cartridge, as per the instructions in the product sheet 

supplied with the cartridge. 

22. Analyze the run according to “Protocol 6: Analysis of a PyroMark Q24 Run”, page 34. 
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Protocol 6: Analysis of a PyroMark Q24 Run 

This protocol describes the mutation analysis of a finished RAS Extension Pyro V2 run using 

PyroMark Q24 Software. 

Procedure 

1. Insert the USB stick containing the processed run file into the computer’s USB port. 

2. Move the run file from the USB stick to the desired location on the computer using 

Windows Explorer. 

3. Open the run file in the AQ mode of PyroMark Q24 Software either by selecting “Open” 

in the “File” menu or by double-clicking the file ( ) in the shortcut browser. 

4. There are two methods for analyzing the run. If using the RAS Extension Plug-in Report, 

go to step 5. If using the AQ analysis integral to the PyroMark Q24, go to step 6.  

Note: We strongly recommend using the RAS Extension Plug-in Report for result 

interpretation. The RAS Extension Plug-in Report can be downloaded from the relevant 

catalog page on www.qiagen.com under the “Product Resources” tab in the Protocol 

Files section. This report ensures that the respective limit of detection (LOD) values and 

different “Sequences to Analyze” are used to automatically detect all mutations. 

5. Using the RAS Extension Plug-In Report to generate a Plug-in report, select “AQ Add On 

Reports/RAS Extension” from “Reports” in the menu (Figure 6). 

Note: Mutations in KRAS codon 61must in addition, be analyzed with the separate KRAS 

plug-in by selecting “AQ Add On Reports/RAS Extension” from “Reports” in the menu. 
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Figure 6. RAS Extension Plug-In Report menu. 
 

The wells will automatically be analyzed for all mutations for which LOD is given in Table 9, 

page 40. The results will be presented in an overview table (Figure 7, next page), followed 

by the detailed results which include Pyrograms and analysis quality. 
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Figure 7. RAS Extension Plug-In Report. 

 

6. Using AQ analysis: 

To analyze the run and get an overview of the results click one of the “Analyze” buttons. 

 

 Analyze all wells. 

 Analyze the selected well. 

The analysis results (allele frequencies) and quality assessment are displayed above the 

variable position in the Pyrogram trace. For more details on how to analyze a run, see 

the PyroMark Q24 User Manual. 
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To generate a report, select “AQ Full Report” or “AQ Analysis Results” in the “Reports” menu. 

The standard “Sequence to Analyze” as defined in the Analysis Setup, addresses the 

most frequent point mutations in the RAS Extension Pyro V2 assays. If a sample contains 

a less frequent mutation, the sequence to analyze can be changed to also analyze the 

mutation status at this position, as described in “Appendix A: Setting Up RAS Extension 

Pyro V2 Assays”, page 48. 

Updated frequencies of mutations in the human KRAS and NRAS genes are provided 

online by the Sanger Institute at www.sanger.ac.uk/genetics/CGP/cosmic/. 

Note: For reliable results, we recommend single peak heights above 30 RLU. Set 30 RLU as 

the “required peak height for passed quality” in assay setup and ensure that the A-peak 

reduction factor is set to 0.86 for analysis of NRAS codon 61 (see Appendix A: Setting Up 

RAS Extension Pyro V2 Assays”, page 48, and the PyroMark Q24 User Manual). 

The “AQ Analysis Results” report should be used for documentation and interpretation of 

allele quantification. The numbers shown in the Pyrogram are rounded and do not show the 

exact quantification. 

Note: The Pyrogram should always be compared to the histogram, which can be 

displayed by right clicking in the Pyrogram window. The measured peaks should match 

the height of the histogram bars. 

Re-analysis of samples with no mutation detected with the standard “Sequence to 

analyze” or with “Check” or “Failed” quality assessment. 

We strongly recommend manually reanalyzing all samples with no mutation detected 

with the standard “Sequence to Analyze”, as well as samples which received “Check” or 

“Failed” quality assessment. “Check” and “Failed” quality assessments may indicate a 

mutation that is not addressed by the standard “Sequence to Analyze”, resulting in 

unexpected reference peaks. 

To reanalyze and target other mutations, go to “Analysis Setup”, and change to 

“Sequence to Analyze” to variants described in Table 11 and Table 12 in Appendix A 

or variants for other rare or unexpected mutations. Click “Apply”, and then click “To All” 

when the “Apply Analysis Setup” window appears. 
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Note: After changing “Sequence to Analyze”, ensure that the threshold for single peak 

height is set to 30 RLU, and ensure that the A-peak reduction factor is set to 0.86 for 

analysis of NRAS codon 61 (see “Appendix A: Setting Up RAS Extension Pyro V2 

Assays”, page 48). 

Note: Additional rare or unexpected mutations may be present in the sequenced region, and 

could be analyzed using alternative “Sequence to Analyze”, considering unexpected 

mutations. If a Pyrogram trace cannot be aligned with one of the provided “Sequence to 

Analyze”, the pattern simulation tool in in Table 11 and Table 12 can help identify rare 

mutations by simulating the expected pattern of an unknown mutation. The pattern simulation 

tool can be obtained from QIAGEN Technical Service. 

Note: In case the measured peaks do not match the height of the histogram bars and 

cannot be explained by rare or unexpected mutations, the result is not a basis for 

judgment of mutational status. It is recommended to rerun the sample. 

Re-running samples for detection of low-level mutations 

We strongly recommend that the unmethylated control DNA is included in every run for 

comparison, and as a control for background levels. Samples showing a mutation 

frequency only slightly higher than the corresponding position in the control sample, should 

be examined in relation to the table showing the limit of detection (see Table 9, page 40). 

If using the RAS Extension Plug-in Report, this is performed automatically. As a guide, 

samples that have a suspected mutation in the range from LOD (Table 9) to LOD + 3 

percentage units, should be re-run in duplicate together with a sample with unmethylated 

control DNA. If using the RAS Extension Plug-in Report (step 5), a warning will be issued if 

this occurs. The result of both duplicates should be ≥ LOD and different from the control 

sample. Otherwise, the sample should be judged as “No Mutation Detected”. 
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Note: The Pyrogram should always be compared to the histogram, which can be 

displayed by right-clicking in the Pyrogram window. The measured peaks should match 

the height of the histogram bars. The Pyrograms should be examined for the appearance 

of unexpected peaks. If the measured peaks do not match the height of the histogram 

bars and cannot be explained by rare or unexpected mutations, it is recommended to 

rerun the sample. The failed result is not a basis for judgment of mutational status. For a 

valid mutation, a change in the peak height is always related to a corresponding change 

in height of another peak. A change in height of a single peak should not be rated as 

indicative of a mutation. 

Note: It is recommended to use the RAS Extension Plug-in Report for result interpretation. 

For closer examination of samples with a reported potential low level mutation, we 

recommend to additionally analyze the sample manually in the application software 

(e.g., for comparison to the mutational frequency of the control sample). 

Note: The frequencies of mutations as given by the PyroMark software and in the “AQ 

Analysis Results” report do not necessarily reflect the percentage of mutation. 
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Table 9. LOD determined for specific mutations 

 Nucleic acid substitution Amino acid substitution LOD (% units) COSMIC ID* (V70)  

KRAS codon 59 (GCA) 

175G>A 

 

A59T 

 
3.5 

 
546 

 176C>G A59G 3.5 28518  

 KRAS codon 61 (CAA) 

183A>C Q61H 2.8 554 

 

 182A>T Q61L 3.1 553  

 182A>G Q61R 3.5 552  

 183A>T Q61H 2.6 555  

 181C>G Q61E 3.1 550  

 KRAS codon 117 (AAA) 

351A>C 

 

K117N 

 

4.0 

 

19940 

 

 351A>T K117N 7.1 28519  

 KRAS codon 146 (GCA) 

436G>A 

 

A146T 

 

6.6 

 

19404 

 

 436G>C A146P 4.8 19905  

 437C>T A146V 5.1 19900  

 NRAS codon 12 (GGT) 

34G>A 
G12S 

3.4 
563 

 

 34G>T G12C 2.5 562  

 34G>C G12R 2.4 561  

 35G>A G12D 3.8 564  

 35G>T G12V 8.8 566  

 35G>C G12A 2.5 565  

 NRAS codon 13 (GGT) 

37G>A 

 

G13S 

 

3.2 

 

571 

 

 37G>T G13C 3.2 (4)† 570  

 37G>C G13R 2.3 569  

 38G>A G13D 2.8 573  

 38G>T G13V 2 (5)† 574  

 38G>C G13A 2.8 575  
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 Nucleic acid substitution Amino acid substitution LOD (% units) COSMIC ID* (V70)  

 NRAS codon 59 (GCT) 

175G>A 

 

A59T 

 

6.9 

 

578 

 

 176C>G A59G 3.0 –  

 NRAS codon 61 (CAA) 

181C>A 

 

Q61K 

 

6.7 

 

580 

 

 182A>G Q61R 2.2 584  

 182A>T Q61L 2.1 583  

 183A>T Q61H 1.8 585  

 183A>C Q61H 8.0 586  

 183A>G Q61Q 5.8 587  

 NRAS codon 117 (AAG) 

351G>C 

 

K117N 

 

4.4 
– 

 

 351G>T K117N 6.0 –  

 NRAS codon 146 (GCC) 

436G>A 

 

A146T 

 

4.4 

 

27174 

 

 436G>C A146P 7.2 –  

 437C>T A146V 7.8 –  

* From the Catalogue of Somatic Mutations in Cancer, available online at the Sanger Institute at 
www.sanger.ac.uk/genetics/CGP/cosmic. 

†  Lowest mutation level in a sample resulting in a measured frequency ≥LOD. 
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Representative results 

Representative Pyrogram results are shown in Figure 8 through Figure 15. 

 
 

 
Figure 8. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the KRAS 59/61 assay. 
 
 
 
 

 
Figure 9. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the KRAS 117 assay. 
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Figure 10. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the KRAS 146 assay. 

 

 
Figure 11. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the NRAS 12/13 assay. 
 
 
 

 
Figure 12. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the NRAS 59 assay. 
 

 



 

 

RAS Extension Pyro V2 Kit Handbook    05/2016 44 

 
Figure 13. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the NRAS 61 assay. 
 
 
 

 
Figure 14. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the NRAS 117 assay. 
 
 
 

 
Figure 15. Pyrogram trace obtained after analysis of a sample with a wild-type genotype with the NRAS 146 assay. 
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Troubleshooting Guide 

This troubleshooting guide may be helpful in solving any problems that may arise. For more 

information, see also the Frequently Asked Questions page at our Technical Support Center: 

www.qiagen.com/FAQ/FAQList.aspx. The scientists in QIAGEN Technical Services are 

always happy to answer any questions you may have about either the information and 

protocols in this handbook or sample and assay technologies (for contact information, see 

back cover or visit www.qiagen.com). 

Refer to the PyroMark Q24 User Manual for general troubleshooting of the instrument. 

 Comments and suggestions 

“Check” or “failed” result 

a) Low peak height Handling errors in PCR setup or sample preparation prior to Pyrosequencing 
can result in low peaks.  

It is important that the samples are completely taken up by the vacuum tool. 
Take care that the vacuum tool is lowered slowly into the samples and that the 
geometry of the PCR plate or strips used for immobilization allows complete 
take up of the samples.  

Perform the function test for filter probes as described in the PyroMark Q24 
User Manual on a regular basis, and exchange filter probes when indicated. 

In case of a “Check” warning, carefully compare the Pyrogram to the 
histogram, which can be displayed by right-clicking in the Pyrogram window. 
If the measured peaks match the height of the histogram bars, the result is 
valid. Otherwise, we recommend rerunning the sample. 

b) Mutation not defined in 
“Sequence to Analyze” 

Adjust the “Sequence to Analyze” in the assay setup (see “Appendix A: 
Setting Up RAS Extension Pyro V2 Assays”, page 48), and reanalyze the run. 
Mutations that are not covered with “Sequences to Analyze” can be identified 
with the pattern simulation tool. 

c) Unexpected rare mutation A “Check” or “Failed” quality assessment can be caused by an unexpected 
pattern of peaks. This might indicate an unexpected mutation, which is not 
analyzed by the provided “Sequence to Analyze”. These samples should be 
analyzed using the alternative “Sequence to Analyze” considering 
unexpected mutations. Mutations that are not covered with “Sequences to 
Analyze” can be identified with the pattern simulation tool. 
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 Comments and suggestions 

d) High peak height deviation 
warning for a dispensation 

The Pyrogram should be carefully compared to the histogram, which can be 
displayed by right-clicking in the Pyrogram window. In case the measured 
peaks do not match the height of the histogram bars and cannot be explained 
by rare mutations, we recommend rerunning the sample. 

High background 

a) Incorrect storage of 
nucleotides 

Store nucleotides at 2–8°C. Storage at –15 to –25°C can cause an increase 
in the background. 

b) Short cooling time of 
samples prior to 
Pyrosequencing analysis 

Keep the samples on a PyroMark Q24 plate holder at room temperature for 
10–15 minutes. Do not shorten the cooling time. 

c) Contamination of cartridge Carefully clean the cartridge as described in the product sheet. Store the 
cartridge protected from light and dust. 

No signals in positive control (unmethylated control DNA) 

a) Insufficient enzyme or 
substrate mix for all wells 

Make sure to fill the PyroMark Q24 Cartridge according to the “Pre Run 
Information” in the “Tools” menu. 

b) Reagents incorrectly stored 
or diluted 

Prepare the reagents according to the instructions in “Reagent Storage and 
Handling” on page 14 and “Protocol 5: Running the PyroMark Q24” on 
page 31. 

c) PCR or sample preparation 
failure 

Carefully clean the cartridge as described in the product sheet. Store the 
cartridge protected from light and dust. 

  

Quality Control 

In accordance with QIAGEN’s ISO-certified Quality Management System, each lot of the 

RAS Extension Pyro V2 Kit is tested against predetermined specifications to ensure consistent 

product quality. 
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Contact Information 

For technical assistance and more information, please see our Technical Support Center at 

www.qiagen.com/Support, call 00800-22-44-6000, or contact one of the QIAGEN 

Technical Service Departments or local distributors (see back cover or visit 

www.qiagen.com). 
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Appendix A: Setting Up RAS Extension Pyro V2 
Assays 

If the RAS Extension Plug-in Report has been installed, predefined Assay Setups for KRAS codons 

59/61, 117, and 146 and NRAS codons 12/13, 59, 61, 117 and 146 are available in the 

shortcut browser of the PyroMark Q24 software. Follow the path “Example Files/PyroMark 

Setups/RAS Extension”. In this case, the following steps do not need to be performed.  

The RAS Extension Plug-in Report can be downloaded from the relevant catalog page on 

www.qiagen.com under the “Product Resources” tab in the Protocol Files section. 

We strongly recommend the use of the RAS Extension Plug-in Report over manual analysis.  

After installation of the Plug-in or each time new software is installed or upgraded on the 

computer, the correct function of the plug-in should be verified as described in the RAS 

Extension Plug-In Quick Guide. 

If the RAS Extension Plug-in Report has not been installed, the assay file must be set up 

manually before running the RAS Extension Pyro V2 assay for the first time. Set up the assay 

for KRAS codons 59/61, 117, and 146 and NRAS codons 12, 13, 59, 61, 117 and 146 

by using the PyroMark Q24 Software, as described below. 

Procedure 

1. Click  in the toolbar and select “New AQ Assay”. 

2. Table 10 shows the “Sequences to Analyze” to analyze for all eight RAS Extension Pyro 

assays. Type the assay specific sequence in “Sequence to Analyze” field. 

3. The “Sequence to Analyze” can also be changed after the run to analyze for mutations 

at different positions (see “Protocol 6: Analysis of a PyroMark Q24 Run”, page 34). 
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4. To check if mutations are present in other nucleotides, change the “Sequence to 

Analyze” according to Table 10. Changing the “Sequence to Analyze” is possible after 

the run (if not locked). 

Note: Ensure that the threshold for single peak height is set to 30 RLU. Additionally, 

ensure that the A-peak reduction factor is set to 0.86 for analysis of NRAS codon 61. 

5. Manually enter the assay specific “Dispensation Order” from Table 10. 

Note: Do not use the “Generate Dispensation Order” button. Both “Sequence to 

Analyze” and “Dispensation Order” must be typed in manually. 

6. Click the “Analysis Parameters” tab, and increase “Peak Height Threshold - Required 

peak height for Passed quality:” to 30. 

7.  Click  in the toolbar, and save the assay as “KRAS 59/61” or “KRAS 117” or “KRAS 

146” or “NRAS 12/13” or “NRAS 59” or “NRAS 61” or “NRAS 117” or “NRAS 146”. 
 

Table 10. Assay setup: “Sequence to analyze” and “Dispensation order” for the eight assays of the RAS Extension Pyro 
V2 Kit 

 RAS Extension assay Sequence to analyze Dispensation order  

KRAS 59/61 CTCDTGACCTGCTGT GCTCAGTCAGACTAGCATGA 

 KRAS 117 ATAAHTGTGA GATGACTCGTG  

 KRAS 146 ATCAVCAAAGA GATCAGCTGAGC  

 NRAS 12/13 GNTGNTGTTGGGAAAAGC TACGACTCAGCATCGTAGAG  

 NRAS 59 ACAGNTGGAC TGACTAGCATGA  

 NRAS 61 CNAGAAGAGTA TCGTATCGAGAG  

 NRAS 117 ABTGTGATTT GACGTGTGA  

 NRAS 146 CANCCAAGACCA GCAGTCAGAC  
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Table 11. Common mutations in the human KRAS gene detected by the RAS Extension Pyro V2 Kit with respective 
“Sequence to analyze” 

 Nucleic acid substitution Amino acid substitution Sequence to analyze Cosmic ID (V70)*  

KRAS codon 59 (GCA)    

 175G>A A59T CTCTTGACCTGNTGT 546  

 176C>G A59G CTCTTGACCTNCTGT 28518  

 KRAS codon 61 (CAA)     

 183A>C Q61H CTCDTGACCTGCTGT 554  

 182A>T Q61L CTCTHGACCTGCTGT 553  

 182A>G Q61R CTCTHGACCTGCTGT 552  

 183A>T Q61H CTCDTGACCTGCTGT 555  

 181C>G Q61E CTCTTSACCTGCTGT 550  

 KRAS codon 117 (AAA)     

 351A>C K117N ATAAHTGTGA 19940  

 351A>T K117N ATAAHTGTGA 28519  

 KRAS codon 146 (GCA)     

 436G>A A146T ATCAVCAAAGA 19404  

 436G>C A146P ATCAVCAAAGA 19905  

 437C>T A146V ATCAGBAAAGA 19900  

      

* From the Catalogue of Somatic Mutations in Cancer, available online at the Sanger Institute at 
www.sanger.ac.uk/genetics/CGP/cosmic/. 
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Table 12. Common mutations in the human NRAS gene detected by the RAS Extension Pyro V2 Kit with respective 
“Sequence to analyze” 

 Nucleic acid substitution Amino acid substitution Sequence to analyze Cosmic ID (V70)*  

NRAS codon 12 (GGT)    

 34G>A G12S NGTNGTGTTGGGAAAAGC 563  

 34G>T G12C NGTNGTGTTGGGAAAAGC 562  

 34G>C G12R NGTNGTGTTGGGAAAAGC 561  

 35G>A G12D GNTGNTGTTGGGAAAAGC 564  

 35G>T G12V GNTGNTGTTGGGAAAAGC 566  

 35G>C G12A GNTGNTGTTGGGAAAAGC 565  

 NRAS codon 13 (GGT)     

 37G>A G13S NGTNGTGTTGGGAAAAGC 571  

 37G>T G13C NGTNGTGTTGGGAAAAGC 570  

 37G>C G13R NGTNGTGTTGGGAAAAGC 569  

 38G>A G13D GNTGNTGTTGGGAAAAGC 573  

 38G>T G13V GNTGNTGTTGGGAAAAGC 574  

 38G>C G13A GNTGNTGTTGGGAAAAGC 575  

 NRAS codon 59 (GCT)     

 175G>A A59T ACAVCTGGAC 578  

 176C>G A59G ACAGNTGGAC –  

 NRAS codon 117 (AAG)     

 351G>C K117N ABTGTGATTT –  

 351G>T K117N ABTGTGATTT –  

 NRAS codon 61 (CAA)     

 181C>A Q61K VAAGAAGAGTA 580  

 182A>G Q61R CNAGAAGAGTA 584  

 182A>T Q61L CNAGAAGAGTA 583  

 183A>T Q61H CANGAAGAGTA 585  

 183A>C Q61H CANGAAGAGTA 586  

 183A>G 
 
 

Q61Q 
 
 

CANGAAGAGTA 
 
 

587 
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 Nucleic acid substitution Amino acid substitution Sequence to analyze Cosmic ID (V70)*  

 NRAS codon 146 (GCC)     

 436G>A A146T CANCCAAGACCA 27174  

 436G>C A146P CANCCAAGACCA –  

 437C>T A146V CAGBCAAGACCA –  

* From the Catalogue of Somatic Mutations in Cancer, available online at the Sanger Institute at 
www.sanger.ac.uk/genetics/CGP/cosmic/. 
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Appendix B: Emptying the Waste Container and 
Troughs 

WARNING  

Hazardous chemicals 

The Denaturation Solution used with the vacuum workstation contains sodium 

hydroxide, which is irritating to eyes and skin. 

Always wear safety glasses, gloves, and a lab coat.  

The responsible body (e.g., laboratory manager) must take the necessary 

precautions to ensure that the surrounding workplace is safe and that the 

instrument operators are not exposed to hazardous levels of toxic substances 

(chemical or biological) as defined in the applicable Safety Data Sheets 

(SDSs) or OSHA,* ACGIH,† or COSHH‡ documents. 

Venting for fumes and disposal of wastes must be in accordance with all 

national, state, and local health and safety regulations and laws. 

* OSHA: Occupational Safety and Health Administration (United States of America). 
†   ACGIH: American Conference of Government Industrial Hygienists (United States of America). 
‡   COSHH: Control of Substances Hazardous to Health (United Kingdom). 

 

Be sure to observe federal, state, and local environmental regulations for the disposal of 

laboratory waste. 

Important point before starting 

 This protocol requires high-purity water. 
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Procedure 

1. Ensure that no vacuum is applied to the vacuum tool. Make sure that the vacuum is 

closed (Off) and the vacuum pump is turned off. 

2. Discard any solutions left in the troughs. 

3. Rinse the troughs with high-purity water, or replace them if necessary. 

4. Empty the waste container. 

5. The cap can be removed without disconnecting the tubing. 

If the vacuum workstation must be cleaned (for example, due to dust or spillage), follow the 

instructions in the PyroMark Q24 User Manual. 
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Ordering Information 

Product Contents Cat. no. 

RAS Extension Pyro V2 Kit (24) For 24 reactions: Sequencing Primers, 
PCR Primers, Unmethylated Control 
DNA, PyroMark PCR Master Mix, 
CoralLoad Concentrate, Buffers, and 
Reagents 

970590 

PyroMark Q24  Sequence-based detection platform for 
Pyrosequencing of 24 samples in 
parallel 

9001514 

PyroMark Q24 Vacuum 
Workstation 

Vacuum Workstation for preparing 24 
samples in parallel, from PCR product 
to single-stranded template 

9001516 
 

PyroMark Q24 Software Analysis software  9019062 

Accessories  

PyroMark Q24 Plate (100) 24-well sequencing reaction plate  979201 

PyroMark Q24 Cartridge (3)  Cartridges for dispensing nucleotides 
and reagents  

979202 

PyroMark Vacuum Prep Filter 
Probe (100)  

Reusable filter probes for PyroMark 
Vacuum Workstation Q96 and Q24 

979010 

PyroMark Control Oligo  For installation check of system  979203 

PyroMark Q24 Validation Oligo  For performance confirmation of system  979204 
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Product Contents Cat. no. 

Related products   

QIAamp DNA FFPE Tissue Kit 
(50) 

For 50 DNA preps: 50 QIAamp 
MinElute® Columns, Proteinase K, 
Buffers, Collection Tubes (2 ml) 

56404 

EZ1 DNA Tissue Kit (48) For 48 preps: Reagent Cartridges 
(Tissue), Disposable Filter-Tips, 
Disposable Tip-Holders, Sample Tubes 
(2 ml), Elution Tubes (1.5 ml), Buffer 
G2, Proteinase K 

953034 

PAXgene Tissue Containers (10) For collection, fixation, and 
stabilization of 10 samples: 10 
Prefilled Reagent Containers, 
containing PAXgene Tissue FIX and 
PAXgene Tissue STABILIZER 

765112 

PAXgene Tissue DNA Kit (50) For 50 DNA preps: PAXgene DNA 
Mini Spin Columns, Processing Tubes, 
Microcentrifuge Tubes, Carrier RNA, 
and Buffers; to be used in conjunction 
with PAXgene Tissue Containers 

767134 

 

For up-to-date licensing information and product-specific disclaimers, see the respective 

QIAGEN kit handbook or user manual. QIAGEN kit handbooks and user manuals are 

available at www.qiagen.com or can be requested from QIAGEN Technical Services or your 

local distributor.  
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Trademarks: QIAGEN®, Sample to Insight®, QIAamp®, BioRobot®, CoralLoad®, EZ1®, HotStarTaq®, MinElute®, Pyro®, Pyrogram®, PyroMark®, Pyrosequencing® 
(QIAGEN Group); Variomag® (Thermo Fisher Scientific); Axygen® (Corning Inc.); FrameStar® (4titude Ltd); Milli-Q® (Merck Millipore Corporation); PAXgene® 
(PreAnalytiX GmbH); Sepharose® (GE Healthcare); SmartBlock™, ThermoMixer® (Eppendorf AG); Windows® (Microsoft Corporation). 

Limited License Agreement for RAS Extension Pyro V2 Kit 

Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 

1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components contained in the panel 
only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this panel with any components not included 
within this panel except as described in the protocols provided with the product, this handbook, and additional protocols available at www.qiagen.com. Some of these 
additional protocols have been provided by QIAGEN users for QIAGEN users. These protocols have not been thoroughly tested or optimized by QIAGEN. QIAGEN 
neither guarantees them nor warrants that they do not infringe the rights of third-parties.  

2. Other than expressly stated licenses, QIAGEN makes no warranty that this panel and/or its use(s) do not infringe the rights of third-parties. 

3. This panel and its components are licensed for one-time use and may not be reused, refurbished, or resold. 

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 

5. The purchaser and user of the panel agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited above. QIAGEN 
may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court costs, including attorney fees, in any 
action to enforce this Limited License Agreement or any of its intellectual property rights relating to the panel and/or its components. 

For updated license terms, see www.qiagen.com. 

May-16 HB-1889-002 © 2016 QIAGEN, all rights reserved. 
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